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Introduction

Congratuiations on your purchase of the Diamond Graphical Operating System. It is a powerful
new user interface that will tie your Atari 8-bit computer in with the future. With Diamond you will no
longer be forced to use clumsy command lines or menus, but instead you will use a mouse to make
selections via drop-down menus, dialog boxes, windows, and icons. Welcome to the future!

What is Diamond GOS?

An operating system is the backbone of every computer. Once you turn on your computer the
operating system takes over. If your computer’s operating system (OS for short) is limited then external
programs such as spreadsheets are iorced to do more work on their own. Conversely, if you have a
powerful OS, other programs do not need to work as hard. The OS in the Atari 8-bit computer was
designed around 1978. It includes routines to handle I/0 (Input/Output), floating point math functions,
and simple graphics, but little more.

Most Atari owners are familiar with the term DOS (Disk Operating System). DOS acts as an
extension of the existing OS and handles file management on disks. It contains many commands that
relate to controlling a disk drive. '

Diamond is a GOS (Graphical Operating System). It acts as an extension of the OS by providing
additional functions relating to the use of a graphical interface. It handles everything from drop-down
menus, icons, and windows to drawing lines and boxes. Diamond GOS simplifies creation of a program’s
user interface and likewise provides users with a very friendly and familiar environment regardless of

the application being used.

Set Up

Your Diamond GOS package includes both a cartridge and a disk. The cartridge contains both
the GOS and DeskTop software. The disk contains various utilities for the configuration of the Diamond
GOS environment along with Diamond Paint and Diamond Write which are covered later in this manual.

Mouse Configuration

Diamond is preconfigured for an Atari ST Mouse in joystick port 1. While we highly recommend
the use of an ST Mouse, we do not expect that everybody will use one so we have included a program
called CONFIGUR.APP on our utilities disk that allows you to reconfigure Diamond for use with a
joystick or other input device with an appropriate driver. If you wish to reconfigure your system for an
alternate input device boot up Diamond GOS, and then load this utility from the Utilities disk. To load
a program with Diamond you must move the mouse pointer (arrow) over to Drive A, double-click on
the icon so that a window opens with a list of files on that disk, and then double-click on the filename
in the window. To move the mouse pointer use the arrow keys, and to double-click rapidly press the space
bar twice. Please note that further references to the mouse in this manual refer to whatever input device
you elect to use. Included drivers allow for the use of a joystick or touch tablet with Diamond GOS.

Using the GOS

As we have surely made you aware by now, Diamond GOS isnot just another program, but rather
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anenvironment that will greatly extend the lifespan of your computer. Included in this package are a paint
program for creating pictures and illustrations and then printing them out, and a word processor for
writing documents. We also have other Diamond GOS applications available along with a Development
kit for programmers that wish to create their own Diamond based applications.

Mouse Usage

Most aspects of Diamond revolve around the mouse. The mouse is used to point to various options
and click on them in order to select them.

There are three operations that can be performed with the mouse. They are dragging, clicking,
and double-clicking. Dragging is done by holding the mouse button down, clicking is done by pressing
the button once, and double-clicking is done by pressing the mouse button twice in rapid succession.
Double-clicking needs precise timing otherwise it will appear as two ordinary clicks. You may wish to
practice this on our DeskTop, however, once you learn how to do it, it will become a cinch.

The mouse cursor can, depending on the input driver being used, also be controlled from the
keyboard by pressing the four arrow keys (no otherkeys need to be held down in conjunction with them),
and the space baris used as the button. It is not possible to drag items with the keyboard as only one button
can be recognized at one time.

Drop-Down Menus

Drop-down menus are the menus that appear at the top of the video screen, and, when pointed
at by the mouse pointer, they ‘drop-down’ into the work area of the screen. One can select an item in
a drop-down menu by pointing at it and then clicking the mouse button (the item will become inverted
when it is pointed to). Some items in a drop-down menu may be in light text meaning that they are
unavailable at that time. When the mouse pointer leaves the drop-down menu area that menu will

disappear.

Icons
Icons are pictures that appear on the screen and can be clicked on or dragged. InDiamond DeskTop
the disk drives and trash can are icons.

Windows ,

Windows usually represent the work area for a project. Diamond allows for up to four windows
to be used, however application programs are not required to use all four windows as doing so consumes
much memory and system resources (e.g. the DeskTop uses two at most).

A windows consists of twelve parts as follow:

Closer - Located in the upper left corner of a window. This is used to close the window. Activate
by clicking it.

Title/Drag Bar - Located at the top of a window. This contains information about what a window
contains and allows for a window to be dragged to a new position on the DeskTop. Activate by dragging.

Fuller - Located in the upper right corner of a window. This is used to make the window occupy
the entire screen. Activate by clicking it. Clicking it again will go back to normal size.

Subtitle - This is the area under the title/drag bar. It gives information about the contents of the
window.



Up Arrow - Moves the window contents up one notch. Activate by clicking it.

Vertical Slider - Moves the window contents up/down any number of notches. Activate by
dragging of clicking on the slide bar.

Down Arrow - Moves the window contents down one notch. Activate by clicking.

Sizer - This is located in the lower right corner of a window. Allows for a window to be resized.
Activate by dragging it.

Right Arrow - Moves the window right one notch. Activate by clicking.

Horizontal Slider - Moves the window contents left/right number of notches. Activate by
dragging it or clicking anywhere on the slider bar.

Left Arrow - Moves the window contents left by one notch. Activate by clicking it.

Work Area - The area inside a window. Check with the documentation of the program in
determining what goes on here.

Note: Not ALL of the above items must be active for any given window. Diamond DeskTop, however,
supports all of a window’s functions.

Dialog Boxes

Dialog boxes contain ‘touch sensitive’ areas which are sensitive to being clicked on. Diamond
gives complete flexibility in the design of dialog boxes so please check with the instructions that
accompany a program in using them. When using a dialog box the mouse is used to point at various
buttons in it, and the RETURN key can be used to select a default button which is usually highlighted
with a thicker border.

Dialog boxes can also be used for the input of text from the keyboard (only when absolutely
necessary!). When doing this the mouse pointer will disappear and a cursor will appear. In this situation
the ESCape key will clear the text area, and the backspace key will function as normal. Other keys vary
depending on the software.

The File Selector

Diamond GOS uses a file selector that is found in many Diamond-based applications such as the
included Diamond Paint and Diamond Write. Through the file selector you can use the mouse to select
a file you wish to access. At the top of the file selector is a title line. This line tells you what purpose you
are selecting a file for. The lower left side of the box lists the files on the disk...to select one of these files
simply double-click on it. If you single click on a file you will have selected that file, but must also ‘press’
the OK button to continue. If you want to cancel selection of any file then press the Cancel button. On
the lower right side of the file selector are the filename that has been selected, the OK and Cancel buttons,
and a column of 7 buttons that may or may not have the letters A through G in them. The letters are used
to select a new disk drive for reading a file from. Clicking on one of these will cause the directory on
that drive to be used for selecting a file

If you are using a DOS that supports folders/subdirectories then clicking on a file with the
extender ‘>’ will open the folder, and to the root of a subdirectory click on the closer in the upper-left
comer of the listing of files (it looks identical to a window's closer box).

Diamond DeskTop



Diamond DeskTop acts as a replacement for the various DOS menus that accompany existing
DOS types. It is a complete Diamond GOS based application using windows, icons, drop-down menus,
and dialog boxes. It will allow you to do most standard DOS functions, however, it is much more
enjoyable to use and most tasks can be accomplished much faster with a DeskTop. It can even be used
to execute existing software, but, of course such programs will not take advantage of Diamond GOS’s
capabilities.

Disk Drives

Diamond DeskTop allows for the use of up to seven disk drives. Most DOS types available today
usedrive numbers to identify one disk drive from another, however Diamond DeskTop uses letters. When
using disk drives the unit number can range from 1 to 8, and drive letters can range from A to G. If you
are unsure about how to use this feature we recommend that you use drive A as unit 1, drive B as unit
2, etc... until it becomes more clear.

Diamond DeskTop Layout

Diamond DeskTop is laid out with up to seven drive icons an one trash can. Diamond also uses
drop-down menus to select from various operations. The menu bar has four headings: Desk, File, Disk,
and Options. They contain the following menu items:

Desk
Info - Provides information about Diamond DeskTop such as the version number..

File
Open - Opens a window for the selected drive displaying the contents of the disk in the drive.
Status - Gives the status of a file (length, protect status), and allows the user to rename the file.
Note: When renaming a file ESCape will only clear the current part of the filename that is being
edited. To clear the entire filename press Shift-Clear. This will hold true for many Diamond GOS
operations relating to disk filenames such as with our file selector box.

Duplicate - Allows for a single drive file copy. This operation will require several passes
depending on the amount of memory in your system so we recommend that you use a two drive system
for copying files and disks.

New Folder - This function is only used by DOS XE and S_partaDOS asDOS 2.X does not support
the creation of folders. Folders are used to categorize files on a disk. Please refer to your DOS manual
on usage. To create a folder: open a window, select this option, click on the folder name area, and then
enter a name. Extenders are not used when creating a folder with Diamond DeskTop.

Close - Closes the active window or, if in a folder, goes to parent directory of the folder.

Quit - Exits from the DeskTop to a cartridge (e.g. the built in Basic on an XL/XE computer).
I you are using an older 400/800 computer then this function will not work.

Disk
Format - Formats a disk in the selected drive. If you wish format disks in densities other than
the default for DOS please use an appropriate utility. IT IS UP TO DOS TO RECOGNIZE THE
VARIOUS DISK DENSITIES AND NOT DIAMOND!
Copy - Copies an entire Single Density disk. To do so select this option and enter the source and
destination drive letters (or drag one disk icon to another), select whether the destination disk should be
formatted before writing to it and then click OK.



Option

Display - Allows for the selection of a different sort key that should be used when directories
are read (so that files are listed by name, extender, or size), and whether to show files with text filenames
or icons. Diamond uses three types of icons: folders, programs, and data. Folders will obviously be shown
as folder icons, files with APP, COM, EXE and OBIJ extenders will be shown as programs, and other
files will be shown as data.

Please note that if a program does not have one of these four extenders and you attempt to load
it, then it will load and function as normal. If a data file has one of the extenders used for programs and
you attempt to load it then you will be presented with our Show/View dialog box. These icons are only
used to make the DeskTop more visually attractive.

Please note that Diamond based applications must either have the extender APP or COM,
otherwise the Diamond cartridge will be disabled so that other (non-Diamond) programs can load
normally.

Confirm - Allows you'to set a flag for the confirmation of potentially hazardous operations (e.g.
formatting a disk, or deleting a file). When this is set an ‘Are You Sure?” alert box will prompt you to
verify an action.

Install - Installs/removes disk drive icons on the DeskTop. To do so click on the unit number and
enter the appropriate drive unit number from 1 to 8, then click on drive letter and select an unused letter
(A-G). After VALID information has been entered select the appropriate button and click on it.

Note: Ifyouinstall a drive that does not exist and perform disk directory operation on it the computer
will appear to crash. This is merely a timeout which can last for about two minutes. To escape from this
hit the break key.

Save DeskTop - Saves the current DeskTop settings (Display parameters, the confirm option,
window positions, screen colors . . . etc) on the disk in drive 1.

Icons

Icons are selected by clicking on them with the mouse. You can drag the icons to anywhere on
the DeskTop. Clicking on an icon selects the disk drive or gives information for the trash can. Double
clicking on a disk icon opens a window showing the contents of that disk.

VWindows

Windows contain disk directories (alist of files contained on the disk). These files can be dragged
to icons or windows, or they can be selected by clicking on them. Dragging a file to another window,
or to a disk icon results in a file copy. Dragging an icon to the trash can results in the deletion of the file.
Double clicking on a file executes it if it’s a program, allows the file to be viewed or printed if it is data,
or opens the folder if it’s a folder.

The Diamond DeskTop handles two windows at a maximum. When two windows are open you
can select between them by clicking on them. The active window will have a filled title bar.

Performing DOS operations with Diamond Desktop

Disk Directory
A disk directory is obtained by double clicking on one of the disk drive icons on the DeskTop.
When this is done a window will open and it will list the files on the disk. If you are using a DOS that

supports Time/Date stamping of files these will alsobe displayed. If you wish to get another disk directory
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insert the new disk and press ESCape. An alternative to double clicking on a drive icon is clicking and
selecting Open from the file menu.

Run Cartridge
This is the same as our Quit option on the file menu. It will use the built in Basic cartridge on
XL/XE computers. To get back to the DeskTop from Basic use the DOS command.

Copy Files
To copy a file you can select the file while it appears in a window and select duplicate from the
file menu, or drag the file to another disk drive icon or window. The file will then be copied to the selected
destination. When using the duplicate option the destination drive will be the same as the source drive.

Delete Files/Folders
To delete a file or a folder drag it to the trash can. Please note that only empty folders can be

deleted, otherwise a disk error will occur.

Rename File
To rename a file you must select it while it appears in a window and then select the status option

from the File menu. You can then click on the file name (provided that the file is not locked) and rename
it.

Lock/Unlock (Protect/Unprotect)
To lock or unlock a file simply select the file in a window and then select Status from the File

menu and click on the Protect box. If the protect box is filled then the file is locked. Please note that when
the file is locked it can not be renamed.

Format Disk
Select a drive by clicking on the appropriate drive icon, and then select format.

Copy Disk
Select Copy from the disk menu, or drag one disk drive icon onto another.

Binary Load
Double click on the program file.

Other Features of Diamond DeskTop

Command Line
Files with a COM extender are considered to be Command Line files. When executing such files

you will be asked toenter various parameters. This allows various options to be passed from the DeskTop
to another program. I you do not need any parameters to be entered then simply press RETURN and
the program will be executed as if it were a normal APP file. The command line used by Diamond is not
the same as the one used by SpartaDOS, however Diamond’s command line is SpartaDOS compatible
when SpartaDOS is active.

Folder Support
Diamond fully supports the creation of folders (subdirectories), however, the extender is not used
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for naming folders. Please do not try and use it by renaming your folders as problems may occur. If you
wish to copy items into a folder you must use window to window copying with one window being the
folder you are copying into.

Time/Date Support
When using Diamond with DOS XE or SpartaDOS time/date stamps will be shown in directories.

Tagging
Tagging is a method of selecting multiple files for copies and deletes. This way a group of files
can be copied or deleted in one operation. To tag a group of files simply hold the Shift key down while
clicking on file names. Once this is done dragging any of the selected files for a copy or delete will result

in all of the tagged files being copied or deleted!

Appendices

Configuration

Configuration of the Diamond environment so that it matches your system is essential in order
to get the most out of Diamond GOS. Configuration is done with a CONFIG.OS file that resides on your
StartUp disk. This file is read when Diamond GOS first loads and it contains the following information:

Mouse Click Time and Port Number
Mouse Driver info
Memory Driver info

The mouse click time and port number can be set with the CONFIGUR.APP utility. Click time
~ is the delay used to react to successive presses of the mouse button. It is listed in jiffies (1/60th of a

second). The default for the system is 12. The port number is the joystick port that the attached input
device is hooked up to. The default is port 1.

The mouse driver is a custom program used to read the various input devices. The default is the
ST mouse. This can be reconfigured with CONFIGUR.APP.

The memory driver is a custom program used to access various types of bank-select memory. This
is among the more powerful and complicated features of Diamond as it allows for up to 16 Megabytes
of memory to be accessed. In the future this is a key feature that will greatly expand the potential of your
computer. This can be configured with CONFIGUR.APP also.

For those of you interested in the methods used read the following explanation:

In Atari 8-bit computers the microprocessor has a 16 bit address bus. This means that memory
locations must range from 0 to 26-1 or from 0 to 65535. This allows a maximum of 64K to be accessed
directly at any given time. By today’s standards 64K is somewhat small. Due to this hardware limitation
many memory upgrades have appeared that allow you to expand your system’s memory by using a
method called bank selecting. What this means is that you may have several banks of memory that can
be switched in at a certain location, however, only one bank can be accessed at any given time. This is
much more difficult to program with, hence there has never been a great use for such memory.

Up to present day most memory upgrades have been used as large RamDisks. Personally I felt
that this was rather silly as it was waste of memory that could be accessed by programs for extensive data
storage, so with Diamond we have integrated a complete set of memory drivers that will automatically
handle bank selecting. To represents a standard method of using such memory in the Diamond GOS
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environment and consequently all memory upgrades will appear to work the same for a Diamond based
application. This is a superior method of accessing extra memory, and will cause Diamond based
applications to utilize such memory in the best way possible depending on the application you are using.

Desk Accessories

Desk Accessories are handy little programs such as calculators, note pads, clocks, and even smail
games that can be used while another (presumably larger) application is running. Imagine that you are
writing a paper and you realize that you must calculate the product 1234 and 5678 for inclusion in the
paper. Just think of how much more convenient it would be to have a calculator accessory on the DeskTop
as opposed to searching for a real calculator (or doing it by hand?).

Diamond allows for up to six Desk Accessories to be resident at any given time. This depends
upon available memory as Desk Accessories also use expanded memory, as discussed previously, for
storing these accessory programs. On a standard 48K system you have about 1K for Desk Accessories
(just.enough for some small ones). To access such accessories look under the leftmost menu or the menu
bar. Accessory names will appear under a dashed line if any are resident. Desk Accessories are identified
by an ACC filename extender and must reside on your StartUp disk so that they can be immediately
loaded when entering the Diamond GOS environment.

Diamond Paint

Introduction to Diamond Paint

Welcome to Diamond Paint, our powerful graphics program that allows you to draw freehand,
create lines, boxes, rays, circles...etc to create beautiful drawings with ease. Diamond Paint also has
features such as magnify and mirror that you’ve come to expect from paint programs, but some of the
additional features such as the ability to place text directly onto your drawing in any combination of eight
different styles set Diamond Paint apart from any other painting program available for the Atari 8-bit
computer. Diamond also allows you to cut and paste images on Diamond Paint drawings and allowsthese
images to be saved as clip art for later use. Finally, Diamond Paint allows you to import images from
other systems through the use of import modules so that pictures can be shared. We hope you enjoy using
Diamond Paint.

To use Diamond Paint from Diamond DeskTop you must :

1. Load the DIAMOND GOS disk or Cartridge.

2. Insert the Diamond GOS Disk in the drive you are using to load from.

3. Double click on that drive’s iconto get a list of program’s on the GOS disk.

4, Now double click on the icon labeled PAINT.APP and Diamond Paint will load.

Note: If you have an XL/XE or a memory upgrade IT WILL BE NECESSARY TO FIRST
CONFIGURE Diamond GOS so that it can use this extra memory as some Diamond Paint features
require more than 48K.

If your computer is limited to 48K of memory you will be able to use all functions outlined in
this manual except for the following:

1. You will be required to save your working picture each time you exit to the Diamond Paint
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main menu. Failing to do so will result in the loss of the picture in memory.
2. You will NOT be able to print a picture.
3. You will be unable to load/save clip art.

Using Diamond Paint

Once Diamond Paint loads you will be presented with a familiar menu bar and arrow pointer. At
this point you can perform such tasks as loading pictures, loading clip art, or even importing pictures from
other paint programs (from other computers). The three menus that you are presented with are Info, Desk,
and Font. Under the Desk menu is the familiar Info line that displays information about Diamond Paint.
The Desk menu also has any desk accessories that have been loaded. The other two menus contain the

following items:

File

Paint a Picture - Goes directly to the paint screen so that you can start painting a new picture
from scratch (or, if you have enough memory, continue painting an existing picture).

Modify Picture - Loads a picture from disk and then goes to the paint screen.

Load Clip Art - Allows clip art to be loaded into memory. Clip art is basically a small portion
of a picture that you can paste on another picture.

Save Clip Art - This function allows clip art to be saved to disk.

Import - This function allows pictures to be imported from other formats thus allowing you to
use pictures on your computer that were drawn on other systems. Diamond uses import modules to
accomplish this so as not to limit itself to any one format. To use this function you must first select the
appropriate Import module from disk. Once the needed import module has been loaded you can then
select the picture to load. Please note that this function clears the cut/paste buffer.

Print - Allows a picture tobe printed. When selected this option will prompt youto selecta printer
dump module before printing. This feature only works on systems with 64K or more memory.

Compression - Toggles compression on and off. If compression is on a check mark will appear
by the side of this option and pictures will be loaded and saved in a compressed format (the same one
used by Micro Illustrator).

Quit - Exits Diamond Paint and returns to the DeskTop.

Font
Font - Allows a new typeface to be loaded for the placement of text on a picture. Diamond fonts

use a DFT extender.
Style - Allows the text style to be changed. Diamond uses eight different styles, and text can be

displayed using any combination of styles. Once selected you will be presented with a dialog box listing
the various styles. To select/deselect a style click on the box to the left of the style name.

The Work screen

Once you enter the Diamond Paint work screen you can begin painting. On the work screen there
isa toolbox containing 16 icons that represent the various functions that can be performed from Diamond
Paint. If you do not like the position of the toolbox it can be dragged elsewhere on the work screen with

the mouse.

Toolbox Functions

Draw - Allows for freehand drawing to be done. To do so select the draw icon from the toolbox.
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To start drawing simply hold down the mouse button and move the mouse pointer around the screen.
When you are done release the mouse button.

Line - Allows you to draw a line. To do so hold the mouse button down on the starting point of
your line and then drag the mouse to the endpoint of the line. You will see a ‘ghost’ line follow the mouse
pointer. When you are satisfied with the positioning of the line release the mouse button.

K-Line - A k-line is a continuous line. To draw one click on the starting point of your k-line. The
toolbox will then disappear. Next click on the points that you wish to connect When you are done hold
down the mouse button and the toolbox will return.

Rays - Allows rays to be drawn. To do so select this option from the toolbox and then click on
an initial point. The toolbox will then disappear. You can then click on an end-point and a ray will be
drawn connecting the initial point to the end point. To get the toolbox back simply hold down the mouse
button.

Box - Allows boxes to be drawn. To draw a box hold down the mouse button on one of its corners
until the toolbox disappears. You can then drag the mouse to the opposite corner of the box. A ‘ghost’
outline of the box will follow you. When you are satisfied with the region that you wish to draw the box
over release the mouse button. If you wish to get a filled box double-click on this tool.

Circle - Allows a circle to be drawn by holding down mouse button and dragging it horizontally
on the screen. Release mouse button when the circle appears where you want it to be. If you want a filled
circle, double-click on the circle tool.

Ellipses - Allows for an ellipse to be drawn in the same manner as a circle, except both X and
Y motion affects its size. Double-clicking on the option gives a filled ellipse.

Fill - Allows for an area tobe filled with the current selection. Simply click on the area to befilled.
Please note that if area that is being filled contains one of the colors being filled then a fill will not be
permitted.

Text - Allows for text to be placed on the work screen. To create text simply click on the point
that text should be placed and a cursor will appear. Enter the needed text and press RETURN when done.

Eraser - Allows for a portion of the picture to be erased or by double-clicking this the entire
picture can be erased.

Mirror - Allows for a mirroring effect to be used in conjunction with other drawing options.

Magnify - Allows for fine touch up work to be done by magnifying a section of the picture. When
selecting you can activate magnify mode by clicking anywhere on the picture. In the lower left and right
corners of the screen you will see the region that the mouse pointer is on being magnified. You can plot
pointsby clicking on button, or you canreturn to the toolbox by holding the button down. You can ‘zoom’
in on the magnified region by double-clicking on the area and then editing in the magnified square. To
return to normal mode click anywhere outside of the magnified region.

Brushes - Picking on this option will give you a menu of different paint brushes that can be
selected. To select a brush point to it and click on it.

Cut/Paste - Cut and paste allows you to cut an area from the picture and then place it anywhere
else on the picture. These pieces can also be loaded/saved to disk as clip art. To activate cut simply click
on Cut/Paste and then (by dragging the mouse) create a box around the region of the picture that you want
to cut. Once the button is released that area will be cut and you will then be in paste mode. To paste your
piece simply drag the mouse over the picture. You willsee a ‘ghost’ frame the size ofthe cut region follow
the mouse. When you find the area that you wish to paste to release the mouse button. When in Paste
mode you can also exit to the menu screen and save your clip art to disk. If you wish to cut another piece
out of picture simply single click on Cut/Paste from the toolbox and you will again be in cut mode. Please
note that double-clicking on the toolbox puts you in paste mode if clip art has been loaded and thus allows
you to load clip art, double-click on cut/paste, and then paste your clip art on the screen.
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Colors - The color selection option allows you to select brush patterns and change the system’s
colors. When selected you will be presented with a dialog box containing sixteen brush patterns on the
left and the four system colors on the right. To select a brush pattern simply click on any of the sixteen
boxes, and to change a color simply click any of the arrows above or below the appropriate color. The
up arrow increments the color, and the down arrow decrements the color. The leftmost arrow in a pattern
changes the hue, and the rightmost arrow changes the luminance. To exit without altering anything
simply press RETURN.

Exit - Exits from the work screen back to the title screen. When this option is selected you will
be presented with a dialog box consisting of the currently selected filename, and buttons for Save, Abort,
and Cancel. To save your picture using the currently selected filename click on Save. If you wish to save
it under a new filename click on the filename. Selecting Abort will not save your picture, but will exit
to the title screen. Selecting Cancel will return back to the work screen.

Expanded Memory Systems

If you are using a system that is configured with 64K or more memory your work screen will be
saved when you exit to the title screen, and restored when Paint a Picture is selected. This allows you
to load additional clip art or select a new font/style of text. On 48K systems the paint screen will be lost
when exiting to the title screen.

Systems with expanded memory also have the ability to print their picture.

Selecting Font Sizes

Diamond Paint allows you to use different sizes of text with the Text tool by selecting a different
brush. The first brush represents the smallest size characters and the sizes increase with brush selections
from left to right. Changing the font (typeface) or style being used must be done from the Text drop-down
menu only available from Diamond Paint’s title screen.

Editing Diamond Paint Text

When typing characters in Diamond Paint use the backspace key to delete unwanted characters
on a line, however this will also erase any part of your picture under the text that was typed. Use the Caps
key to change from upper case to lower case in the line on which you are typing or you can use the Shift
key to get upper case characters.

You can not edit a line once you have pressed the RETURN key as what is written to the screen
is actually graphical and not stored in text format (i.e. it’s a picture of the text). Cut and paste canbe used
to reposition text lines in your picture. Use the eraser to erase unwanted text from the screen.

Diamond Write

Introduction to Diamond Write

Welcome to Diamond Write, our powerful graphics oriented word processor for the Diamond
GOS environment. Diamond Write contains most of the features found in other word processors, and
adds a graphics display thus enabling you to have a WYSIWYG (What you see is what you get) output,
and also the ability to use different styles of text in your documents. One of the best features of Diamond
Write, however, is its ability to generate an eighty column display on the screen so that the entire width
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of a document is displayed on screen at once.

Getting Started

Diamond Write uses all available memory as its document buffer. This means that on a 48K
machine there will be a very small document size due to memory (about a page of text), but on a bigger
machine such as a 130XE there will be ample room for a sizable document.

Diamond Write also requires that Diamond be configured with a mouse driver that DOES NOT
accept keyboard input to move the mouse for smooth operation. This is because the mouse can be used
to position the cursor in the edit window (explained later), and if we aliowed the space bar to act as a
‘click’, then every time you pressed the space bar you would be repositioning the mouse cursor. Mouse
driversare included on the Diamond Write disk for this, and configuration is done with the CONFIGUR.APP
that was included with your Diamond GOS package.

To load Diamond Write from the DeskTop simply find the application titled WRITE.APP and

. double-click on it. Diamond Write will then load.

Drop-Down Menus

Diamond Write uses five drop-down menus. These are Desk, File, Edit, Mode, and Font. Toselect
one of these options simply point to the menu that they appear under, point to the item on the menu (it
will be highlighted), and press the mouse button. The options listed beneath each menu are as follow:

Desk-
Info - Shows the version number of Diamond Write.

File-

New - Erases the current document from memory.

Load - Loads a document from disk into memory for editing.

Save - Saves the document in memory to disk using the currently selected filename. This name
appears in the title bar of the editing window.

Save As... - Allows you to select a new filename before saving the file.

Print - Prints your document.

Quit - Exits Diamond Write and returns to the DeskTop.

Edit-
Cut - After marking a block of text you can Cut it out of your document into the cut/paste buffer

with this menu option.
Copy - This performs the same function as cut, except it does not remove the block of text from

your document, but instead just copies it into the cut/paste buffer.
Paste - This option pastes the cut/paste buffers contents where the cursor is positioned.
Search - This will search through your document starting from where the cursor is positioned

for the occurrence of a specified string.
Replace - This will search through your document for the occurrence of a specified string AND

replace it with another string.
Spelling - Currently our spelling checker is not complete and consequently this does nothing. It

is here for future expansion.

Mode-
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Page Layout - This allows you to adjust the page layout for Diamond Write. It allows you to
select between single/double/triple line spacing, and Page Numbering for printouts.

Graphics Mode - This toggles graphics mode on and off and is used for printouts only. When
Graphics mode is on you will get a graphics printout, but when graphics mode is off you will geta straight
printout with no special graphics or styles imbedded in your document.

Reformat - This reformats the document so that it looks cleaner and neater.

Justification - This allows you to select the type of justification being used. Left/Right/Center/
Full justification are all offered.

Ruler - This allows you to see a graphic ruler at the top of the edit window to show you where
you are placing text in your document. It can be used for lining words up so that no guesswork will be
required when you print your document.

Font-
Font - This allows you to load a new font for your document. Only one font can be used in a

document, and this font will be used for a WYSIWYG display.
Style - This allows youtoselect a new style of text such as underline or italics. Styles can be mixed
and matched throughout the document.

The Editor

The Diamond Write editor is very easy to use. Once Diamond Write loads up you will see the
edit window. It acts just like a standard window as is used in the DeskTop, but you can not drag it, resize
it, or full it (as it is already fulled). The title bar of the window contains the name of the file that you are
editing, and the subtitle bar contains information such as the amount of memory available in your system,
and the number of lines used in your document. Clicking on the closer will quit the program.

The slider bars allow you to scroll through your document at an accelerated pace, and the closer
will close the edit window and exit Diamond Write back to the DeskTop. Inside the edit window is a
vertical bar cursor. When you type text it appears at this location. You can scroll back through the text
with the arrow keys, and you can delete unwanted characters with the backspace key. You can also use
the mouse to position the cursor in the edit window by clicking at any location.

Loading and Saving Documents

Loading and saving of your documents is accomplished by the drop-down menu options under
the file menu. Included on the disk is a sample document called DEMO.DOC. To load this document
click on load from the File menu and then Open the file DEMO.DOC from our file selector box. The
document will load and will appear in the edit window. Feel free to play around with the editor, and once
you are done you can save your newly edited document. To doso click on Save As... so that you can select
a new filename before saving (clicking on Save will result in the new file being saved over the original
DEMO.DOC file). Now select a filename and select OK and the document will be saved.

Printing

Printing of your document is accomplished with the Print option found under the File menu.
When in Graphics Mode (found under the Mode menu) you will be able to get a WYSIWYG printout
on your printer. When Print is selected a file selector box will appear and will ask you to select a printer
driver. Once a driver has been selected printing will commence. Be sure that your printer s setup propetly
before printing.

If you are not in Graphics Mode you will receive a non-graphic printout, and no special fonts or
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styles will be included. This type of printout MAY be faster and thus useful for proofreading your
document or getting a draft copy printed quickly.

Cut and Paste
The cut, copy, and paste options are listed under the edit menu. Normally these option will be
unavailable, because in order to cut or copy text a block of text must first be selected

The block will then be inverted, and cut/copy will be available from the Edit menu.
Clicking on cut or copy will invoke that operation and Paste will become highlighted. You will then be
able to paste that block in your document.

Search and Replace

~ Search and Replace are both available from the Edit menu. The difference between the two is
that Search only finds a specified string in your document, and Replace’will search for astring andreplace
it with another string automatically. Select one of these functions from the Edit menu and you will be
prompted by a Dialog box allowing you to input your search string and for Replace a replacement string.
Once this has been done click on OK and the search will begin from where your cursor was positioned.
If you are doing a search once the specified string has been found the search will end and you will see
the found string in your document. If no occurrence of this string was found you will be at the end of
the document. For Replace you have the option to replace only the first occurrence of the string in your
document OR you can replace all occurrences of the string. This is done with the additional All button .
in the Dialog box.

Eighty Column Operation

Diamond allows for eighty-column operation via the ability to use an eighty-column font. It is
included on your disk and can be loaded with the Font option under the Font menu. The font does not
actually yield 80 columns on the screen, but instead it will give about 64 columns. If we were to try and
stretch it to eighty columns we fear that it would be next to impossible to read with a standard monitor.
We also realize that on eighty column business letters only 65 columns are normally used as usually an
inch is taken up for the margins, consequently we think this is the best way to go if you must see the full
width of your document on the screen at once.

Layvout

Diamond Write allows you to have your document single, double, or triple spaced. This is done
via the Page Layout Dialog box. Diamond Write also allows you to use Left/Right/Center/Full
justification. This can be selected via the Justification dialog box found under the Mode menu. Please
note that any justification used will only take effect on printed copies and will notbe visible on the screen.

When editing your document, some lines may ‘hang’ off the right side of your document. To
alleviate this you can reformat your document with the Reformat option found under the Mode menu.

Fonts and Styles

One of the more impressive capabilities of Diamond Write is its ability to have a WYSIWYG
display. It also allows you to use a different font or typeface in your document. To load a different font
go to the Font menu and click on Font. A file selectorbox will allow youtoload a Diamond font (extender
DFT). Some fonts have been included on your Diamond GOS Utility disk such as the eighty column font
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mentioned earlier. Once this font has loaded the document in memory will be displayed using it.

You can not mix and match fonts within a document. You can, however, use different styles
within a document. This is done by selecting Style from the Font menuy, clicking on which styles you
wish to be active, and then clicking on OK. Your document will be seen thh all these styles active, and
your printout will appear just like the characters do on screen.

Warranty

If you have any questions about Diamond GOS or the included applications please contact us at
the address below. Before calling please be sure that you have read this manual first.

29W150 Old Farm Lane
Warrenville, IL 60555
(708) 393-2317
we are also available on both GEnie and CompuServe:

GEnie ID: REEVE.SOFT
CIS ID: 71521,2200
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